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Rendering
“There’s nothing quite like turning a grey-shaded model into something that looks real - or that could 

be real.” Lee Lainier

Rendering ist der Vorgang indem aus der modellierten Szene ein Bild errechnet wird. Zunächst 
muss man eine Render Engine auswählen danach muss man der Szene und den Objekten mehrere 
Eigenschaften zuweisen:

Materialien
Dem Modell werden Shader zugewiesen. Je nach Typ von Shader können eine Vielzahl von echten 
sowie unechten Materialien simuliert werden. 

Lichter und Schatten
Um die Szene zu Beleuchten setzt man virtuelle Lampen in den Raum. Diese sind nach realen 
Lampen von Filmsets nachgeahmt. Diese Lampen geben ein direktes Licht ab, jedoch werfen diese 
Lichter keine Schatten. Schatten muss man für jedes Licht einzeln aktivieren. 

Darüber hinaus kann man noch eine „indirekte“ Beleuchtung aktivieren. Dies simuliert die Ei-
genschaft von Photonen, das sie die Farbe annehmen von der Fläche an der sie zuletzt reflektiert 
wurden.

Kamera
Man benutzt beim Rendern immer eine Kamera. Die Kamera funktioniert ähnlich wie eine echte 
Foto/Film-Kamera und definiert den Bildausschnit wie das Bild gerendert wird.
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Workspace Einstellungen
Beim vorbereiten für das Rendern benutzt man den „Hypershade Editor“, die „Render View“ und 
eine Kamera-Ansicht.

Mental Ray Plugin aktivieren
Manche Funktionalitäten von Maya liegen als Plugin vor. Um Plugins in Maya zu laden muss man 
Window > Settings and Preferences > Plugin Manager und dort für das Plugin ein Häckchen 
bei load setzen. (bzw. Auto load damit es automatisch mit Maya geladen wird). 

Viele Beispiele im Skript verwenden das Mental Ray Plugin (Siehe „Mental Ray“ Seite 59). Man 
sollte sicherstellen das Mayatomr.dll aktiviert ist.

Unter Umständen kann das Plugin Deaktiviert werden, wenn Maya z.B. abstürzt dann muss man  
das Plugin nochmals aktivieren. Ein einfaches MEL skript dafür findet man im Anhang. (Siehe 
„Activate Mental Ray Plugin“ Seite 118)

Mental Ray als Standart Renderer einstellen
Damit Mental Ray immer als Standard Renderer zur Verfügung steht kann man unter Window > 
Settings and Preferences > Preferences unter Settings - Rendering bei „Preferred renderer:“ im 
Dropdown Menü mental ray auswählen.

Falls Maya abstürzen sollte und das Plugin nicht geladen wird, wird der Maya Software renderer 
verwendet.
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Grundlagen Rendering

Arbeitsschritte
 - Render Engine auswählen

 - Shader den Materialien hinzufügen, ggf. Texturieren

 - Die Beleuchtung der Szene mithilfe von Lichtern und Schatten definieren

 - Eine Kamera der Szene hinzufügen

 - Test Render

 - Final Render

Render Engines
Die erste Frage die sich beim Rendern stellt ist „Welche RenderEngine soll man verwenden?“. Die 
jeweiligen Renderengines haben ihre Vor- und Nachteile und werden für verschiedene Zwecke ein-
gesetzt und bestimmen daher das weitere Vorgehen. Hier werden die verschiedenen RenderEngines 
vorgestellt.  

Maya Software

Ein Allzweckrenderer der direkt in Maya eingebaut ist - Es ist ein Hybrid Renderer der die Ge-
schwindigkeitsvorteile eines Scanrenderers mit echtem Raytracing verbindet. Generell hat die Qua-
lität des Bildes höhere Priorität als die Geschwindigkeit des Ausrenderns.

Der SoftwareRenderer hat den Vorteil, dass man das IPR (Interactive Photo Realistic rendering) 
Tool verwenden kann um das fertig gerenderte Bild interaktiv verändern zu können. Sowie durch 
seine direkte Integration, dass man einfach komplexe Shadingeigenschaften erstellen kann.

Maya Hardware
Im Grunde ist es ein hardwarebeschleunigter Allzweckrenderer. Im Allgemeinen ist der Hardware-
renderer schneller als der Softwarerenderer, ein weiterer Vorteil des Hardwarerenderers ist das Aus-
rendern von Hardware Partikeln. Jedoch kann der Hardwarerenderer keine Sub-D Objekte rendern 
und hat darüber hinaus noch weitere Limitationen. 

Meistens rendert man alle Objekte mit einem Softwarerenderer aus und lässt die Partikel Effekte 
mit Maya Hardware ausrendern.

Mental Ray
Ist ein photorealistischer Raytrace Renderer. Dieser Renderer kann alle Materialien des Maya Soft-
ware Renderers verwenden und zusätzlich noch spezielle Mental Ray Materialien. Mental Ray kann 
auch den IPR-Renderer benutzen.

Mental Ray ist nicht direkt in Maya eingebaut sondern ist ein Plugin (Mayatomr.mll) 

Maya Vector 
Wie der Name bereits sagt ist Maya Vector ein Vektor Renderer. Dies ist besonders nützlich um 
Blaupausen des  Modells zu erstellen. Die unterstützten Formate sind: Scalable Vector Graphics 
(SVG), Adobe Flash (SWF), Adobe Illustrator (AI) oder Postscript (EPS) 
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Maya Vector wird selten verwendet und ist daher ein Plugin (VectorRenderer.mll)

Weitere Render Engines
Es gibt auch weitere Renderengines für Maya wie z.B. Visual Dynamics - V-Ray (http://www.vray.
com/vray_for_maya/) oder Pixar - Renderman (https://renderman.pixar.com/products/tools/
rfm.html)

Wir werden uns hauptsächlich mit dem Mental Ray Renderer beschäftigen, da dieser Renderer in 
vielen gängigen 3D-Modellierprogrammen, wie 3dsMax zur Verfügung steht.

Eine Render Engine auswählen
Unter den Render Settings direkt unter der Menüzeile ist „Render Using“ ein Dropdown Menü was 
anzeigt welcher Renderer gerade verwendet wird.

Render-Vorbereitungen
Das Rendern braucht sehr viel Rechenleistung und deswegen werden hierfür sog. RenderFarms 
verwendet. Pixar braucht durchschnittlich 7 Stunden um ein einziges Bild für ihre Animations-
filme zu erzeugen, sogar mit ihrer RenderFarm. (Wired Magazine 6/2010) . Daher sollte man viele 
Testrenderings von einzelnen Teilen machen, bevor man einen finalen Render macht. 

Vor jedem Render sollte man unbedingt Abspeichern und alle unnötigen Programme schließen. 
Der Computer wird während dem Rendern üblicherweise kaum bzw. gar nicht reagieren. 

Um den RenderVorgang eines Einzelbildes abzubrechen muss man ESC drücken. Es dauert 1-10sek 
bis der Computer darauf reagiert.

Einen Test-Render erzeugen
In der Regel erstellt man mehrere Test-Render bevor man die Szene ausrendert. Diese Render haben 
eine sehr geringe Qualität und dienen nur um zu sehen ob einzelne Materialien, oder die Beleuch-
tung korrekt eingestellt ist. 
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Arbeiten mit der Render View
Die Render View selbst hat eine Reihe von Funktionen die einem das Arbeiten und das Ausrendern 
sehr erleichtern.

Repeat Last Render
Dieser Button wiederholt einfach, den gleichen Render von der gleichen Kamera mit der man als 
letztes gerendert hat. Ungleich zu dem Button „Render Current Frame“ auf der Status Line, muss 
daher nicht vorher bestimmt werden. D.h. man kann weiter in Maya arbeiten und immer wenn 
man zurückkommt zur RenderView wird die gleiche Kamera ausgerendert.

Render Region/Snapshot

Mit LMB kann man eine rechteckige Auswahl  auf dem Image 
Display Bereich selektieren. Drückt man den Button wird nur 
diese Region gerendert. Um die Auswahl wieder aufzuheben 
muss man einmal kurz LMB klicken.

Dies benutzt man wenn man Details korrigieren möchte ohne 
viel Zeit zu verschwenden  das ganze Bild auszurendern.

Wenn man noch keinen Render von der aktiven Perspektive 
gemacht hat, so kann man auf Snapshot klicken und man be-
kommt einen render von der Szene im Wireframe-Modus. Man 
kann nun ohne raten eine genaue Region auswählen die man aus-
gerendert haben möchte. 

Interactive Photorealistc Render (IPR)
Man benutzt das IPR ist das man schnell einen Überblick bekommen kann wie Lichter und Farben 
wirken. Mit dem IPR kann man eine Render Region auswählen. Der Unterschied zwischen Render 
Region und IPR, ist das man nun Materialeigenschaften verändern kann und die Veränderungen 
werden in Echtzeit in der Render View übernommen. 

Wenn man das IPR verwendet, sollte man die Qualität der Rendering Engine auf sehr niedrig 
stellen dies Erlaubt dem IPR sehr schnell die Veränderungen zu übernehmen. Man kann für das 
IPR-Rendering nur MayaSoftware und Mental Ray verwenden.

Um einen IPR-Render zu erzeugen klickt man auf Repeat last IPR Render und selektiert die Region 
mit der man arbeiten möchte.

Render Settings
Öffnet die Render Settings.

Die RenderView Icons

Beispiel von einem Snapshot und anschlie-

ßender Render Region
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Display RGB/Alpha/Real Size
„Display RGB“ zeigt das gerenderte Bild in Farben an, „Display Alpha“ zeigt den Alpha Kanal an.

Man kann auf dem Bild mit den normalen Camera Kontrollen Zoomen und bewegen. Möchte 
man ein unskaliertes Bild haben, klickt man einfach „Display Real Size“.

Keep Image /Remove Image
Wenn man verschiedene Werte verändert, möchte man machmal einen Vergleich zwischen vorher 
und nacher machen.

Klickt man auf „Keep Image“, so wird das Bild temporär abgespeichert d.h. schließt man Maya so 
werden alle gerenderten Bilder wieder entfernt. Nachdem man ein Bild temporär gespeichert hat, 
kann man nun etwas in der Szene verändern und nochmal rendern. Mit dem Scrollbalken am un-
teren Rand vom Fenster kann man von Bild zu Bild springen.

Möchte man ein Bild nicht mehr sehen so klickt man Remove Image und das aktuelle Bild wird 
entfernt.

Wenn man sich notieren möchte was man eigentlich verändert hat zwischen den Bildern, so kann 
man mit RMB auf die Icons Klicken und „Keep Image with Comment“ auswählen. Der Kommen-
tar wird dann unten bei den Renderinformationen angezeigt.

Render Diagnostics
Die Render Diagnostics öffnet das Output Fenster und zeigt die letzten Meldungen der Render 
Engine an. Dies braucht man wenn z.B. Fehler beim ausrendern auftreten.                                                                

Render Engine
Das Dropdown Menü lässt einen die Render Engine auswählen ohne die Render Settings dafür 
zu öffnen. (Insbesondere ist dies nützlich, wenn Objekte nicht angezeigt werden beim ausrendern. 
Benutzt man z.B. ein mia_material_x so kann Maya Software die Geometrie nicht rendern dann 
kann man hier überprüfen ob man auch mit Mental Ray rendert.)

IPR Controls
Die IPR Controls sind nur dann aktiv wenn man einen IPR Render macht. Der Pause Button 
pausiert den IPR Render, d.h. man kann veränderungen machen ohne das der render sofort neu 
ausgerechnet wird. Daneben ist eine anzeige wieviel zwischenspeicher für den IPR render benötigt 
wird. Und der Rote Knopf beendet das IPR-rendering.
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Kameras
In Maya hat man die Wahl ob man nur ein Einzelbild rendert 
oder eine Animation. Es wird immer eine virtuelle Kamera be-
nutzt um das Bild auzurendern. Es stehen einem immer die 3 
Ortographischen Kameras „top“, „front“, „side“ und die perspek-
tivische Kamera „persp“ zur Verfügung. 

In der Praxis verwendet man die „persp“ Kamera für das Model-
lieren und modifiziert sie oft wenn man sich in der Szene orien-
tiert. Deswegen setzt man immer in die Szene eine neue Kamera 
die nur für das Rendern der Szene verwendet wird.

In Maya gibt es zwei Typen von Kameras. Die Standard Kamera 
simuliert eine Film Kamera und schießt ein einziges Bild. Die 
Stereo-Kamera besteht aus mehreren Standardkameras. Mit die-
ser Kamera können 3D-Bilder erzeugt werden (z.B. für 3D-Ki-
nofilme wie Avatar). Man braucht dann spezielle Displays bzw. 
Brillen um das Bild zu betrachten. Daher werden wir uns nur mit 
normalen Kameras beschäftigen

Eine Kamera erzeugen
Mit Create > Cameras > Camera erzeugt man eine Standart Kamera. 

Man findet auch „Camera and Aim“ und „Camera and Aim and Up“. Alle drei sind die gleiche 
Kamera, nur mit verschiedenen Kontrollattributen aktiviert. Es reicht wenn man eine „Camera“ 
erzeugt. Braucht man später weitere Kontrollen kann man sie im Attribute Editor unter „Camera 
Attributes“- Controls hinzufügen. 

Allgemeine Attribute

Angle of View / Focal Length / Camera Scale

Mit dieser Einstellung lässt sich die perspektivische Verzerrung bestimmen die bei dem verwenden 
von Kameraobjektiven entstehen. Die Wertebereiche für die Focal Length ist für Weitwinkel Ob-
jektive 3-15, für normal Objektive 35-55 und für Telezoom Objektive 100-550. 

Der Öffnungswinkel (Angle of View) und Brennweite (Focal Length) sind direkt voneinander 
Abhängig (d.h. setzt man den einen Wert wird automatisch der andere gesetzt). Das Camera Scale 
Attribut wirkt als Multiplikator für die Angle of View bzw. Focal Length

Teleobjektiv (120mm)Normal (35mm)Weitwinkel (10mm)

perspektivische Kamera

orthographische Kamera
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Near Clip Plane / Far Clip Plane:
Virtuelle Kameras müssen aus praktischen Grüunden  Objekte 
die zu nah bzw. zu weit von der Kamera entfernt sind abschnei-
den. 

Meistens tritt dieser Effekt auf wenn die Far Clip Plane zu nied-
rig gesetzt wurde. Man mulitipliziert den Wert schrittweise mit 
10 um einen geeigenten Wert zu bestimmen. Die Near Clip Pla-
ne bestimmt wie nah Objekte sein können ohne abgeschnitten 
zu werden. Falls Fehler auftreten dividiert man den Wert schritt-
weise um 10.

Anmerkung: Mit der Standard Kamera hat man keine Tiefenunschärfe. Man muss der Kamera 
zusätzlich einen Lens-Shader zuweisen (Siehe „Depth of Field“ Seite 106)

Mit Cameras arbeiten
Wenn man durch ein Panel auf die Szene sieht versucht Maya soviel wie möglich anzuzeigen. Bei-
spielsweise ist die default Renderauflösung 640x480 also 4:3, benutzt man einen 16:9 Monitor wird 
mehr angezeigt als was später gerendert wird. 

Um den Bereich angezeigt zu bekommen der ausgerendert wird, muss man für das Panel das Reso-
lution Gate aktivieren im PanelMenu (View > Camera Settings > Resolution Gate)

Das Resolution Gate wird bestimmt über die Render Settings unter Common > Image Size.

Resolution Einstellungen
Je nach Ausgabe Medium muss man die „Dots per inch“ (dpi) anpassen. z.B. 72dpi sind ausrei-
chend für Fernseher/Monitore, 150-300dpi je 
nach Drucker.

Typische Video Auflösungen:

320x240px (QVGA) bzw 640x480px (VGA): 
auch “Desktop”-Auflösung genannt. Diese ist 
sehr klein und eignet sich gut um Testrender 
zu erzeugen. Seitenverhältnis 4:3

720x480 (DVD): Die Dvd Auflösung Seiten-
verhältnis 4:3

1280x720 (HD720) bzw. 1920x1080 
(HD1080): Der Standard für HD Fernseher 
sowie BlueRay mit Seitenverhältnis 16:9

2K, 3k, 4k: Cinema Standardauflösungen die 
Breite ist z.B. für 2K 2x 1024px die Höhe er-
gibt sich aus dem verwendeten Seitenverhält-
nis.

In den „Image Size“-Presets findet man weitere 
Formate

Far Clipping Plane Error

Resolution Einstellungen
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Grundlagen Lighting
In 3D-Umgebungen gibt es eigentlich kein Licht solange man kein Licht der Szene hinzugefügt 
hat. Daher hat Maya ein eingebautes „Default Light“ dies wird verwendet damit man ohne zusätz-
liche Lichter die Szene ausrendern kann. Insbesondere auch damit man überhaupt während dem 
modellieren irgendwas sehen kann.

Sobald man ein Licht der Szene hinzufügt wird dieses Licht automatisch ausgeschaltet. In manchen 
Fällen gibt es jedoch Konflikte,  daher kann man das Default Light in den Render Settings manuell 
ausschalten.

Direct Lighting
Im Grunde ist Direct Lighting, jede Lichtquelle die einen Schatten wirft. Alle Lampen in Maya 
sind nachgebildet von den gleichen Licht Typen und Beleuchtungs mittel die verwendet werden 
können für eine Filmproduktion. 

Lichter in Maya erzeugen
Man kann entweder über Create > Lights oder über die Shelf Rendering Lichter in Maya erzeugen.

Die Shelf Icons:Ambient Light, Directional Light, Point Light, Spot Light, Area Light, Volume Light

Jedes Licht hat sein eigenes Light-Icon, in den meisten Fällen kommt das Licht von diesem Punkt. 
Das Light-Icon bzw. die Lichtquelle selbst wird beim ausrendern nicht ausgerendert.

Ambient Light

Licht Typen

Ambient Light
Dieses Licht gibt ein weiches Licht in jede Richtung. Es erzeugt 
daher ein sehr diffuses Licht. Die  Intensität hat daher kaum Va-
rianz. 

Das „Ambient Shade“-Attribut bestimmt das Verhältnis zwi-
schen omidirectionalen und direkten Strahlen. Ein Wert von 1 
entspricht das alle Lichtstrahlen von dem Light-Icon in der Szene 
stammen, damit ist es identisch zu einem Point Light. Ein Wert 
von 0 lässt das Licht von der Lampe an jeder Position im Bild 
identisch stark erscheinen (Dadurch gibt es keine Schatten mehr 
und alles sind nur noch Farbflächen). Per Default ist der Wert auf 
0.45 gesetzt.

Daher hat die Positionierung des Lichts nur einen kleinen Ein-
fluss auf das Licht. Auch kann man keine Decay Rate für dieses 
Licht setzen.

Ambient Lights werden eigentlich nicht verwendet, da es einen 
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sehr flachen Eindruck im Bild erzeugt bzw. mit anderen Licht-
quellen hat man mehr Kontrolle über das Licht. Das Licht wurde 
nur der Vollständigkeitshalber erwähnt.

Directional Light
Dieser Licht Typ ermöglicht die Simulation von unendlich vie-
len parallelen Lichtstrahlen von einer unbestimmten Lichtquelle. 
Daher bietet es sich an Directonal Light zu verwenden für Son-
nenlicht.

Dadurch das die Strahlen parallel von einer unbestimmten Quel-
le kommen, spielt die  Positionierung  des Light Icons keine Rolle.  
Nur die Rotation des Light-Icons hat einen Einfluss auf das Licht.

Möchte man z.B.. Sonnenlicht durch ein Fenster strahlen lassen, 
so muss man die Schatten von der Lichtquelle aktivieren anson-
sten wird der gesamte Raum mit Licht erfüllt. 

Point Light
Die Lichtquelle vom Pointlight ist ein einzelner Punkt und Licht 
strahlt von dem Punkt in alle Richtungen. Daher ist es ein gutes 
Licht um Glühbirnen, Kerzen, LEDs oder ähnliches zu simulie-
ren.

Da alles Licht von einem fixen Punkt ausgeht hat nur die Positi-
onierung einen Einfluss aufs Licht.

Spot Light
Sind Lichter die reale Spotbeleuchtungen aus dem Theater/Film 
simulieren. Ähnlich wie das Point Light entstammt das Licht von 
einem bestimmten Punkt, wird jedoch dann durch einen Kegel 
in die Szene projiziert. Die gängigsten Anwendung für diesen 
Licht Typ sind, Taschenlampen, Scheinwerfer und Spotbeleuch-
tungen darzustellen.

Positionierung und Rotation haben einen Einfluss auf das Licht. 
Darüber hinaus kann man den Öffnungswinkel über das Cone 
Angle Attribut verändern um einen größeren/kleineren Bereich 
zu beleuchten.

Area Light
Dieses Licht simuliert eine Fläche aus Lichtern die in eine Rich-
tung strahlt. Das Licht selbst wird von einer Reihe von Sampling-
Punkten aus dem Light-Icon in die Szene in alle Richtungen 
ausgestrahlt. Dies ist ein sehr diffuses Licht wie aus einer Soft-
box. Der Verwendungszweck ist  z.B. Licht aus einem Fernseher, 
Leuchtstoffröhren etc.

Positionierung, Rotation, Skalierung haben einen Einfluss aufs 
Licht. Skalierung verändert gleichzeitig auch die Intensität des 
Lichtes, da die Sampling-Points Anzahl immer gleich bleibt.

Directional Light

Spot Light

Point Light

Area Light
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Volume Light
Das Volume Light ist ein künstlicher Licht Typ. Mit einem Volu-
me Light, funktioniert es wie ein Point Light, nur das Licht exi-
stiert nur innerhalb der Begrenzung des Light-Icons. Das Licht 
entspricht keiner natürlichen Lichtquelle und wird daher nur für 
bestimmte Special-Effects verwendet.

Position, Skalierung haben einen Effekt auf das Licht. Per default 
wird ein Sphärisches Licht verwendet, jedoch wenn man die Ein-
stellungen verändert wie z.B.. die Begrenzung von Sphere zu Box 
ändert dann hat auch die Rotation einen Einfluss auf das Licht.

Allgemeine Attribute

Color
Alle Lichter haben als Standardwert weiß als Farbe. Jedoch kommt in der Natur eigentlich kein 
Licht reines weiß. Sogar das Sonnenlicht ist je nach Tageszeit, rötlich oder bläulich. Florescent blau, 
Glühbirnen haben einen gelblichen Stich.

Intensity
Dies bestimmt die Lichtstärke wenn sie auf eine Oberfläche auftrifft.

Decay Rate
Die Decay Rate definiert den Abfall der Licht-Intensität von Lampen. Benutzt man keine Decay 
Rate, so ist die Licht-Intensität gleich stark egal wo das Licht auftrifft. Daher ist es ein sehr un-
natürlicher Effect wenn man Lichter ohne Decay Rate verwendet. Mit einer Linearen Decay Rate 
berechnet sich die Intensität an jedem Punkt mit Intensity = 1/Distanz (̂Faktor). Die Qua-
dratic als Faktor 2 entspricht das reale Verhalten von Licht. Cubic ist mit einem Faktor von 3 lässt 
die Licht Intensität schneller abfallen als in der Realität und wird nur in seltenen Fällen verwendet.

In den meisten Fällen reicht es jedoch eine Linear Decay Rate zu verwenden, das verbraucht später 
beim ausrendern weniger Ressourcen und ist eine gute Annäherung an natürliche Lichter. 

Im Allgemeinen benutzt man nicht die Formel um zu errechnen wie das Licht eingesetzt werden 
sollte. Man passt die Intensity und Decay Rate ein paar Mal an und nimmt dann ansprechendste 
Variante. (In vielen Fällen muss man die Intensity drastisch erhöhen, damit man das Licht über-
haupt noch sehen kann).

Im Beispiel ist es das gleiche leicht gelbe Point Light, mit verschiedenen Decay Rate Einstellungen.

No Decay, Intensity 1 Linear Decay, Intensity 5 Quadratic Decay, Intensity 25

Volume Light
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Mit Lichtern arbeiten
Man kann die Lampen in der Szene simulieren wenn man 7 drückt. Alternativ kann man im Pa-
nelmenü auf Lighting > Use All Lights. Wenn man in diesen Modus wechselt und keine Lampen 
in der Szene vorhanden sind, dann werden alle Objekte schwarz dargestellt.

Mit dem „Show Manipulator Tool“ (T), bekommt man zwei Move Handles für das Licht, einen 
um die Position des Lichts zu bestimmen und einen um die Ausrichtung zu bestimmen. Man kann 
zusätzlich  z.B. beim Spotlight durch verschiedene Einstellungsmöglichkeiten wechseln indem man 
auf den kleinen Kreis unter dem Pivot klickt.

Anmerkung: Das Spot Light positioniert man am einfachsten 
indem man das Licht selektiert und dann im Panel Menü auf 
Panels > Look through selected Camera. Das Panel verändert 
seine Ansicht sodass man durch das Licht schaut.

Spot Light mit Show Manipulator Tool

Panel aus Perspektive des Spotlights
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Schatten
Für jede Lampe muss man bestimmen ob sie Schatten wirft. Standard mäßig wirft eine Lampe 
keinen Schatten, man muss ihn immer erst manuell aktivieren. Dies ermöglicht einfacher z.B. eine  
drei-Punkt Beleuchtung, wo nur das Haupt-Licht einen Schatten werfen soll und die anderen Lam-
pen möglichst keinen Schatten werfen.

Es gibt zwei Typen von Schattenberechnung, DepthMap Shadows und Raytrace Shadows. Depth-
Map Shadows sind grundsätzlich schneller auszurendern als Raytrace Shadows. Letztere orientieren 
sich mehr an physikalisch realistischen Gegebenheiten. Man kann für jede Lampe entweder Depth 
Map Shadows oder Raytrace Shadows benutzen. In einer Szene kann man jedoch auch beide Schat-
ten Typen vermischen.

Depth Map Shadows
Bei DepthMap Shadows wird eine DepthMap erzeugt und dann 
mit einem Filter verwischt. Die DepthMap ist im Grunde ein 
Bild aus der Perspektive des Lichtes. In diesem Bild ist die In-
formation gespeichert von der Distanz von Objekten gegenüber 
dem Licht. Beim ausrendern wird dann geprüft ob der Punkt 
eine höhere Distanz zum Licht hat als in der DepthMap, ist das 
der Fall, dann wird er dunkel gemacht. Da dies für jeden Punkt 
wiederholt wird entsteht dann ein Schatten.

Im Grunde gibt es für DepthMap Shadows zwei Variablen - Die 
“Resolution” der DepthMap und die “Filter Size”. Der Filter 
bestimmt den Grad des verwischens. 

•	 Um scharfe Kanten bei den Schatten zu erhalten, erhöht man 
die Auflösung und benutzt einen geringen Filter. (Ein Wert 
von 0 für Filter Size entfernt das Verwischen komplett)

•	 Um weiche Kanten zu erhalten benutzt man eine geringe 
Auflösung und einen großen Filter. (Dadurch das man einen 
unscharfen Schatten erzeugen möchte ist eine hohe Auflö-
sung unnötig. So verkürzt man auch die Rechenzeit für das 
rendern. Falls das zu viele Artefakte erzeugt, muss man die 
Resolution und Filtersize erhöhen).

Das Bias Attribut, kann man in den meisten Fällen auf dem Wert 0.001 lassen, falls Artefakte im 
Schatten beim rendern auftreten sollen kann man den Wert in 0.001 Schritten erhöhen.

Der größte Vorteil von DepthMap Shadows ist, das man die DepthMaps nur einmal erstellen muss 
und man dann die DepthMaps wieder verwenden kann. 

Der Nachteil an dem Verfahren ist jedoch das man keine korrekten Schatten von Transparenten 
Objekten erzeugen kann. 

Generell ist die Verwendung von DepthMap Shadows eher trickreich. Es gibt jedoch speziell für 
Mental Ray eine Alternative Einstellungsmöglichkeit die simpler ist. (Fortsetzung „Mental Ray Sha-
dows“ Seite 78)

Depth Map Shadows Scharfe Kante

Depth Map Shadows Weiche Kante
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Raytrace Shadows
Bei Raytrace Shadows werden Shadowrays von der Lampe ver-
schickt und dann dementsprechend eingefärbt. Daher können 
Transparenzen korrekt dargestellt werden.

Es gibt bei Raytrace Shadows 3 Einstellungen:

Shadow Radius/Light Radius/Light Angle 

Bestimmt die Härte des Schattens. 0 erzeugt scharfe Kanten - 1 
erzeugt weiche Kanten. 

Manche Lichter, wie Area Light, haben diese Einstellungsmög-
lichkeit nicht. Die Einstellung wird dann aus der Position und 
Rotation des Lichtes abgeleitet.

Shadow Rays  Je höher der Wert desto höher die Qualität der Schatten, (desto Höher die Render-
zeit)

Ray Depth Limit bestimmt wie oft in einer rekursiven Reflektion ein Schatten sichtbar sind.

Mit Schatten arbeiten
Man kann Panels umstellen, das sie die Schattierung sofort berechnen - ohne das man einen Test-
render erzeugen muss. Man sollte immer erst die gesamte Ausleuchtung der Szene fertig haben und 
dann diesen Modus aktivieren. 

Hierfür aktiviert man im Panelmenü Lighting > Shadows

Dies sollte man wieder deaktivieren wenn man modelliert/animiert, da ansonsten Maya sehr lang-
sam reagiert beim manipulieren von Objekten.

Raytrace Shadows
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Light-Rig
Ein Light-Rig wird verwendet um verschiedene Beleuchtungsszenarien mehrfach zu verwenden. 
Dies erspart einem für jede neue Szene die Gesamte Beleuchtung neu einzustellen.  Ein weiterer 
Vorteil ist das man mehrere verschiedene Modelle hinweg das gleiche Erscheinungsbild wahrt.

Die Limitation von diesem Verfahren ist das es nur dazu dient 
einzelne Modelle auszuleuchten. Für eine Animation braucht 
man seine eigene individuelle Umgebung und Beleuchtung.

Backdrop
1. Zu der SideView wechseln

2. Create > CV-Curves mit x-gedrückt die Kurve zeichen 
(siehe Bild)

3. Duplizieren (STRG-D) und Transform (TranslateX = 12)

4. Surfaces > Loft

5. Wechsel des Maya-Modus  auf Rendering (F6 oder über 
das drop-down menü) Lighting/Shading > Assign new 
Material> mia_material_x

Anmerkung: Im Marking Menu des Lofts (RMB auf den Loft) 
gibt es auch den Befehl. Man kann sich so einen Wechsel zwi-
schen Modulen sparen. 

Schritt 2: Curve

Schritt 4: Fertiges Loft
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6. Im Attribute Editor auf mia_material_x1 wechseln - hier sollte man das Material umben-
ennen auf backdrop_material.

7. Unter Presets das Material MatteFinish > Replace auswählen

Anmerkung: Das Material mia_material_x is generell ein metallisches Material. In diesem Fall 
mit dem Preset MatteFinish, ist es ein Diffuses nicht reflektierendes Material - Ideal herzunehmen 
als Studio Hintergrund. 

8. Man kann nun über die diffuse Einstellungen die Farbe verändern über die Color Eigen-
schaft z.B. in Weiss.

9. Das Loft auf seine Eigene Ebene “Backdrop” setzen.

Studio Lighting: Softbox
Eine Softbox ist ein flächiges Licht was sanft die Umgebung beleuchtet. Eine Softbox hat eine be-
sonders Markante Rechteckige Form in der Reflexion. 

AreaLight
Die Lichtquelle die am nächsten einer Softboxbeleuchtung 
kommt ist das Arealight.

1. Create > Lights > Arealight

2. Im Attribute Editor:

 - Farbe zu einem hellen Gelb (HSV - 60, 0.1,  1)

 - Intensity = 15 und DecayRate auf Linear

 - Schatten einstellen (z.B. Raytrace Shadows Shadow Rays 35)

 - Unter Mental Ray - Area Light - Use Light Shape aktivieren  
 und High Samples auf 32 setzen

3. Das Licht mit dem Show Manipulator Tool (T) positionieren auf  Translate (10,5,10) und auf 
den Ursprung ausrichten mit dem 2. Move Manipulator

4. Das Licht duplizieren (STRG-D) und TranslateX -10

5. Die Lichter auf eine eigene Layer „Two_Softboxes_Arealights“

Schritt 5: Marking Menu on Loft Schritt 6-7: Attribute Editor vom für das Material

Beispiel einer Softbox Beleuchtung
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Area Softbox Beleuchtung

Area-Spotlights
Als Alternative wenn man ein Area-Spotlight verwendet kann 
man die Prenumbra Eigenschaft einfacher und genauer bestim-
men. Jedoch würde die Reflexion von der Area-Spotlight rund 
werden.

1. Create > Nurb Primitives > Plane (Width = 4, RotateX = 
90)

2. RMB auf der Plane > Assign new Material > Surface 
Shader

3. Den Surface Shader ColorOut auf Weiss setzen.

Anmerkung: Der Surface Shader ist ein Materialshader, der nur eine Farbe als Eigenschaft hat. 
Im Grunde ist dieses Material immer einfach nur die Outputfarbe und hat keinerlei andere Eigen-
schaften. Dies ist optimal fuer die Softbox da sie eigentlich nur  eine Lichtquelle ist ohne jegliche 
Eigenschaften.

4.  Create > Lights > Spotlight

5. Im Attribute Editor:

 - Farbe zu einem hellen Gelb (HSV - 60, 0.1,  1)

 - Intensity = 15 und DecayRate auf Linear

 - Cone Angle = 60 (Streuwinkel der Lampe

 - Prenumbra = 20 (Abfall der Lichtintensität - hohe Werte ergeben eine Weiche Kante)

 - Schatten einstellen (z.B. Raytrace Shadows Shadow Rays 35)

 - Unter Mental Ray „use Area Light“ aktivieren und die beiden High Samples auf 32 setzen.

Anmerkung: Man hätte auch direkt eine AreaLight erzeugen können, dies jedoch ermöglicht kei-
nerlei Einfluss auf die Prenubra Eigenschaft.

6. Erst die Plane auswählen und dann das Licht und dann 
Edit >Parent (P) (Dies bewirkt das sich die Plane automa-
tisch mitbewegt mit der Lampe)

7. Die Lampe kann man nun positionieren wo man will. Am 
einfachsten hat man es wenn man die Ansicht im aktiven 
Panel auf Panel >Look Through Selected stellt. Bewegt 
man im Modus “Look through Selected” die Kamera so 
bewegt sich tatsächlich das Objekt was man zuvor ausge-
wählt hat. 

Anmerkung: Drückt man die Taste 7 (Use All Lights) schaltet man alle Lichter ein und man sieht 
grob wie was beleuchtet wird.

8. Nachdem man die erste Kamera positioniert hat, kann man zurück wechseln in die normale 

Plane mit Lanpe
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perspektiven Ansicht indem man über das Menü, Panel > Perspektive > persp, oder über 
die Hotbox (Leertaste länger gedrückt halten), in der Mitte mit der linken Maustaste nach 
oben zieht, benutzt. 

9. Nun kann man die Softbox duplizieren (STRG-D) und wieder positionieren.

10. Die beiden Softboxen nun auf eine eigene Layer “Two_Softboxes_AreaSpotLights” setzen.

Das Lightrig kann nun mit weiteren Layern mit anderen Beleuchtungssituationen ausgestattet wer-
den.

Verwendung des Light-Rigs:

Beispiel: Bauhaus-Stuhl
1. Man öffnet das Lightrig und File speichert es als neue Datei “bauhaus_render.mb” (File > 

Save As)

2. File > Import  “bauhaus.final.mb”

3. Den Stuhl plaziert man auf dem Backdrop so dass er gut beleuchtet ist.

4. Der Stuhllehne weist man ein “mia_material_x” mit dem Preset Chrome zu.

5. Der Sitzfläche gibt man ein weißes Phong Material

6. Create > Cameras > Camera und wählt einen Bildausschnitt (Panel > Look through se-
lected Camera, Resolution Gate)

7. Rendern

Fertig gerenderter Bauhaus-Stuhl


